Workshop 9B SDS-PAGE and Blotting for Protein/Peptide Sequencing

Part I SDS-PAGE
- Introduction
- Casting a discontinuous (Laemmli) polyacrylamide gel
- Running the gel
- Reagents for SDS-PAGE slab gels (Laemmli buffer system)

Part II Blotting to PVDF for Protein/Peptide Sequencing
- Introduction
- Electrophoretic blotting onto PVDF membrane
- Staining of PVDF membrane with Coomassie Blue
- Buffer formulations
- References

Bio-Rad Protein Assay
- Quantifying protein concentration in solution
- References
- Reagents compatible with the Bio-Rad Protein Assay

Folin-Lowry Protein Assay

Protein/Peptide Sequencing
- Principle
- Sample preparation
- Figure 1 Edman degradation
- Figure 2 Edman chemistry by-products
- Figure 3 Standard and two Edman degradation cycles

Useful References for Protein/Peptide Sequencing

Instructions for the Use of a Pipettor

Equipment List
Introduction

Gel electrophoresis is a very powerful and widely used method to separate proteins and other macromolecules. The most commonly used gels are either agarose (used for DNA separations) or polyacrylamide (used for protein separations). The molecules are separated based on gel filtration as well as the electrophoretic mobility of the molecules. However, in gel electrophoresis, the gels retard the large molecules (the reverse of gel filtration chromatography).

Polyacrylamide gels are formed by the co-polymerization of acrylamide and bis-acrylamide (N,N'-methylene-bis-acrylamide). Polymerization is induced by free radicals from the decomposition of ammonium persulfate ($S_2O_8^{2-} \rightarrow 2SO_4^{2-}$). TEMED (N,N,N',N'-tetramethylethylenediamine) is added as a catalyst to accelerate the rate of formation of free radicals from the persulfate. The persulfate free radicals convert the acrylamide monomers to free radicals which then react with unactivated monomers to begin the polymerization reaction. The elongating polymer chains are randomly crosslinked by bis, forming a complex "web" polymer with a characteristic porosity. Oxygen is an inhibitor to polymerization, degassing of solutions may be helpful to ensure reproducibility of the gels.

\[ \text{Acrylamide} + \text{N,N'-Methylenebisacrylamide} \rightarrow \text{Polymer} \]

from "Techniques of Protein Purification"
Sodium dodecyl sulfate polyacrylamide gel electrophoresis (SDS-PAGE) in the presence of a reducing agent (2-mercaptoethanol) is a technique for the separation of polypeptide subunits according to their molecular weight. The protocol involves denaturing the protein sample by heating it in the presence of SDS and a reducing agent. SDS will bind to the protein causing it to unfold, whereas the reducing agent will reduce the intramolecular and intermolecular disulfide bonds. The binding of SDS by the protein confers a net negative charge. The denatured polypeptide will migrate through a gel of known percent acrylamide in the presence of an applied electric field towards the positive electrode (anode). After the electrophoresis is complete, the gel is stained with Coomassie® Blue R-250 to visualize the polypeptide bands. The molecular weight of the polypeptide is inversely proportional to its mobility. The molecular weight of the polypeptide subunit can be estimated directly from a semilog graph of the molecular weight of standard proteins versus their mobility or from a plot of the log of molecular weight versus mobility.

Separation of proteins by SDS-PAGE is an excellent technique for producing individually “purified” proteins. In order to take advantage of this technique for the purpose of amino acid analysis or N-terminal sequencing, the proteins must be transferred to a membrane that is stable to the chemicals used in these analytical procedures. This technique involves the electrotransfer of the proteins separated by SDS-PAGE to polyvinylidene difluoride membrane (PVDF). An activated piece of PVDF is placed carefully on the unstained gel containing the separated proteins and the molecular weight markers. The gel-PVDF sandwich is placed in a specially designed holder that in turn is positioned in a buffer-containing electrophoresis unit. At the pH of the buffer (pH 8.3) most proteins are negatively charged and will migrate towards the positive electrode (anode). PVDF is positioned at the anode side of the sandwich and will capture and bind the proteins. The PVDF is stained with Coomassie® Blue R-250 to locate the protein bands. Sections containing the protein bands can then be excised for amino acid analysis or N-terminal protein sequencing.
Procedure: Casting a discontinuous (Laemmli) polyacrylamide gel
The first step in SDS-PAGE is the casting of a discontinuous (Laemmli) polyacrylamide gel. This type of gel consists of a resolving or separating (lower) gel and a stacking (upper) gel.

1. Assemble the glass plate sandwich by placing the longer glass plate down first. Place two spacers along the short edges of the glass plate. Now place the shorter glass plate on top of the spacers so that the bottom ends of the spacers and the bottom of the glass plates are aligned (see Figure 1).

2. Firmly grasp the glass plate sandwich with the longer plate facing away from you. Gently slide the sandwich into the clamp assembly (see Figure 2). Tighten the top two screws of the clamp assembly (see Figure 3). Do not overtighten the screws.
3. Place the clamp assembly into the alignment slot on the casting stand with the clamp screws facing away from you (see Figure 4). The plates may also be aligned by pressing down on the top of the plates to flush the bottoms of both plates to the lab bench. Gently tighten both pairs of screws on the clamp assembly.

4. Transfer the clamp assembly to one of the casting slots in the casting stand (if you are the first to assemble the sandwich, place the clamp assembly on the side opposite the alignment slot). To attach the sandwich, place the bottom in first and gently push the assembly until it snaps into place (press against the white portions of the clamps). DO NOT push against the glass plates or spacers (see Figure 5).
5. Place a comb into the assembled gel sandwich until the teeth are roughly 2/3 into the sandwich. With a marker pen, place a mark on the glass plate 1 cm below the teeth of the comb. This mark will be the level to which the separating gel will be poured. Remove the comb.

6. In a glass culture tube prepare the monomer solution by combining together the following reagents (for 12.5% acrylamide gel):

**NOTE:** Wear gloves when handling reagents. Acrylamide is toxic.

- 2.14 mL of 30% acrylamide/Bis
- 1.25 mL 1.5 M Tris pH 8.8
- 1.53 mL water
- 50 µL 10% SDS
- 5 µL TEMED

Mix this solution thoroughly by swirling. Avoid aeration.

7. Add 22 µL of 30% ammonium persulfate to the above solution just before you are ready to pour. Mix thoroughly and transfer to the glass sandwich with a glass pipette. Fill to the mark you made on the glass sandwich.

8. Immediately overlay the monomer solution with isobutanol. Put enough isobutanol on top of the gel to cover it but do not overfill. Avoid “bombing” the liquid gel layer.

9. Allow the gel to polymerize for 30 minutes. After polymerization, rinse off the overlay solution completely with distilled water. Remove the remaining water with filter paper.

**NOTE:** If the sample is being prepared for N-terminal protein/peptide sequencing, allow the gel to polymerize overnight.

10. In a glass culture tube prepare the stacking gel monomer solution by combining together the following reagents:

- 0.233 mL of 30% acrylamide/Bis
- 0.50 mL 0.5 M Tris pH 6.8
- 1.23 mL water
- 20 µL 10% SDS
- 1.3 µL TEMED

Mix this solution thoroughly by swirling. Avoid aeration.

11. Place a comb in the glass sandwich and tilt the teeth at a 10° angle. This will prevent air from being trapped under the comb teeth while the monomer solutions is poured.
12. Add 13 μL of 30% ammonium persulfate to the stacking gel monomer solution in the glass culture tube just before you are ready to pour. Transfer the stacking gel monomer solution to the glass sandwich with a glass transfer pipette until the teeth have been covered. Align the comb so it is straight and add the solution to fill completely. The comb is properly seated when the T portion of the comb rests on top of the spacers.

13. Allow the gel to polymerize for 30 minutes. Mark the bottom of each well with a pen to aid in visualization of the wells during loading. After polymerization, remove the comb by pulling it straight up slowly and gently. Rinse the wells completely with distilled water.

**NOTE:** If the sample is being prepared for N-terminal amino acid sequencing, the gel should be allowed to polymerize overnight.

**Procedure: Running the gel**

1. After the stacking gel has polymerized, release the clamp assembly/gel sandwich from the casting stand.

2. Lay the inner cooling core down on the lab bench. Have the clamp assembly with the screws facing you and the wedges towards the top of the cooling core. Carefully slide the clamp assembly wedges underneath the locator slots on the cooling core until the inner glass plate of the sandwich is against the notch in the gasket. Snap the clamp assembly until the cooling core latch engages each side of the clamp assembly. Attach the other clamp assembly/gel sandwich to the other side of the cooling core (see Figure 6).

![Figure 6](image)

3. Place the cooling core into the lower buffer chamber of the electrophoretic cell. Fill the upper buffer chamber with electrode buffer (1:5 5X electrode buffer:water) until the buffer reaches a level halfway between the short and long glass plates.
4. Pour the remainder of the buffer into the lower buffer chamber so that at least the bottom 1 cm of the gel is covered. Swirl the lower buffer with a pipet to remove air bubbles.

5. Prepare the samples for electrophoresis.
   a. Dilute the sample with 4 volumes of SDS-reducing buffer (the sample tube contains 20 µL). About 1 µg of protein per band is required for easy visualization with Coomassie Blue R-250. The final concentration should be 0.5 µg/µL.
   b. Heat the diluted sample at 100° for 4 minutes in a heating block.

6. Load 15 µL of the molecular weight standard into lane 2 of the gel. Insert the gel loading tip to about 1-2 mm from the well bottom BEFORE delivery. Slowly deliver the standard into the well. Load 10 µL of your sample into lane 3 and lane 4. If you are the second to load the gel, load the standard into lane 7 and your sample into lane 8 and lane 9.

7. Place the lid on top of the lower buffer chamber to fully enclose the cell. Match the colors of the plugs on the lids with the jacks on the inner cooling core.

8. Attach the electrical leads to the inner cooling core and the power supply with the proper polarity.

9. Apply power to the cell and begin electrophoresis. Set the power supply to 180 volts, constant voltage. Electrophoresis will take approximately 45 minutes.

10. When electrophoresis is complete, turn off the power supply and disconnect the electrical leads. Remove the cell lid and carefully pull the cooling core out of the lower buffer chamber. Pour off the upper buffer.

11. Remove the clamp assembly from the cooling core by pushing down on both sides of the cooling core latch and up on the clamps until the clamp assembly is released (see Figure 7).
12. Loosen all four screws of the clamp assembly and remove the glass plate sandwich. Push one spacer out from the side of the glass plate sandwich (without removing the spacer) and gently twist the spacer so that the upper glass plate pulls away from the gel.

13. Remove the gel by gently grasping two corners of the gel and lifting off. Cut the gel in half and wrap one half in plastic film for blotting in the next lab period. Use the other half for staining.

14. Place the gel for staining in a box containing Coomassie® Blue staining solution (0.1% Coomassie® Blue/10% acetic acid/40% methanol/water). Stain overnight. 
**NOTE:** Normally the gel would be stained for 30 minutes.

15. Destain the gel with the destaining solution (10% acetic acid/40% methanol/water) for 1-3 hours.

16. Photograph gel. Measure the distance in mm (mobility) of the standard protein bands and the samples from the top of the running gel to the individual protein band. There are two methods for obtaining the molecular weight of the sample.

- **Method 1:** graphic method: On the 2-cycle semilog paper plot the molecular weight (y-axis) against the mobility (x-axis) of the individual protein standard. From the mobility value of the sample on the x-axis, draw a line perpendicular until it intersects with the curve. Next draw a horizontal line towards the y-axis. Read the molecular weight from the y-axis.

- **Method 2:** least squares method: Enter the x-values (mobility in mm) and the corresponding y-values (log\(_{10}\) of the molecular weight) on a scientific calculator or a computer graphics program. From the equation calculate the log\(_{10}\) molecular weight from the corresponding mobility value and obtain the antilog value.

All figures from “Preparative Electrophoresis Review” published by Bio-Rad.
Reagents for SDS-PAGE slab gels (Laemmli buffer system)

30% Acrylamide/Bis

<table>
<thead>
<tr>
<th>Component</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acrylamide</td>
<td>14.6 g</td>
</tr>
<tr>
<td>Bis</td>
<td>0.4 g</td>
</tr>
<tr>
<td>Water</td>
<td>50 mL</td>
</tr>
</tbody>
</table>

Filter and store at 4°C in the dark

1.5 M Tris-HCl, pH 8.8

<table>
<thead>
<tr>
<th>Component</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tris base</td>
<td>27.23 g</td>
</tr>
<tr>
<td>Distilled water</td>
<td>~80 mL</td>
</tr>
</tbody>
</table>

Adjust pH to 8.8 with 1N HCl. Make to 150 mL with distilled water and store at 4°C.

0.5 M Tris-HCl, pH 6.8

<table>
<thead>
<tr>
<th>Component</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tris base</td>
<td>6.0 g</td>
</tr>
<tr>
<td>Distilled water</td>
<td>~80 mL</td>
</tr>
</tbody>
</table>

Adjust to pH 6.8 with 1N HCl. Make to 100 mL with distilled water and store at 4°C.

Tank buffer: 0.025 M Tris, pH 8.3, 0.192 Glycine, 0.1% SDS

<table>
<thead>
<tr>
<th>Component</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tris</td>
<td>12.0 g</td>
</tr>
<tr>
<td>Glycine</td>
<td>57.6 g</td>
</tr>
<tr>
<td>SDS</td>
<td>4.0 g</td>
</tr>
</tbody>
</table>

Add water to 4 liters

SDS reducing buffer

<table>
<thead>
<tr>
<th>Component</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5 M Tris-HCl, pH 6.8</td>
<td>1.0 mL</td>
</tr>
<tr>
<td>Glycerol</td>
<td>0.8 mL</td>
</tr>
<tr>
<td>10% (w/v) SDS</td>
<td>1.6 mL</td>
</tr>
<tr>
<td>2-mercaptoethanol</td>
<td>0.4 mL</td>
</tr>
<tr>
<td>0.05% (w/v) bromophenol blue</td>
<td>0.2 mL</td>
</tr>
<tr>
<td>distilled water</td>
<td>4.0 mL</td>
</tr>
</tbody>
</table>

5X electrode (running) buffer, pH 8.3

<table>
<thead>
<tr>
<th>Component</th>
<th>Concentration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tris</td>
<td>9 g (15 g/L)</td>
</tr>
<tr>
<td>Glycine</td>
<td>43.2 g (72 g/L)</td>
</tr>
<tr>
<td>SDS</td>
<td>3 g (5 g/L)</td>
</tr>
</tbody>
</table>

to 600 mL with distilled water

Store at 4°C. Warm to 37°C before use if precipitation occurs.
Dilute 60 mL 5X stock buffer with 240 mL distilled water for electrophoresis.
Workshop 9B SDS-PAGE and blotting for protein/peptide sequencing

Part II Blotting to PVDF for protein/peptide sequencing

Instructors: Joel Nott, Margie Carter, 1182 Mol. Biol. Bldg., Phone 294-3267, 
protein@iastate.edu, http://www.protein.iastate.edu

Introduction
Blotting is a technique for the electrophoretic transfer of DNA, RNA or protein to a suitable membrane. The method most commonly used for the electrotransfer of proteins to nitrocellulose is that reported by Towbin et al. (1979). For protein sequencing and amino acid analysis the proteins are transferred to a chemically stable membrane, polyvinylidene difluoride (PVDF). In this laboratory experiment we will use the “wet” transfer technique, rather than the “dry” transfer technique. Proteins are first separated by SDS-PAGE, the gel is removed from the electrophoresis cassette (do not stain the gel before blotting) and equilibrated in transfer buffer without methanol. The PVDF membrane is “activated” by dipping it in methanol; it is then placed in transfer buffer containing methanol. The gel-PVDF sandwich is placed in a specially designed holder that in turn is placed in the buffer-containing electrophoresis unit. At the pH of the buffer (pH 8.3) most proteins are negatively charged and will migrate to the anode (positive electrode). In case one suspects the protein has a pI greater than 8.3, a PVDF membrane can be placed at the cathode-side of the gel as well. Alternatively, the pH of the transfer buffer can be adjusted to a higher pH. After transfer, the membrane is stained with Coomassie Blue R-250 and destained to locate the protein bands. Sections containing the proteins bands can then be excised for amino acid analysis and N-terminal protein sequencing.

Procedure: Electrophoretic blotting onto PVDF membrane
NOTE: Please wear gloves to prevent contamination of the PVDF membrane.

1. Equilibrate the gel in equilibration buffer (25 mM Tris, 192 mM glycine, without methanol) for 20 minutes by placing the gel in a container filled with equilibration buffer. This equilibration will facilitate the removal of buffer salts and detergents. If the salts are not removed, the conductivity of the transfer buffer will increase causing an increase in the amount of heat generated during transfer.

2. Cut a piece of PVDF to the dimensions of the gel and label it with a soft pencil to identify the gel and orientation of the membrane. Dip the membrane in methanol, then equilibrate the membrane in transfer buffer by soaking it in buffer for 20 minutes. Also soak two pre-cut (to size of gel) pieces of Whatman No. 1 filter paper.

3. Fill chamber with transfer buffer.
4. Assemble the gel-membrane cassette as follows (see figure below). Place the soaked Whatman No. 1 filter on the Scotchbrite pad, place the equilibrated gel on the filter paper while making sure no air bubbles are trapped between the gel and the filter paper. Carefully align one end of the PVDF with the edge of the gel and lower it onto the gel taking care not to trap air bubbles between the PVDF and the gel. Place the second piece of filter paper onto the PVDF in the same manner. Close the cassette and slide it into the TransBlot apparatus, with the PVDF facing the anode (positive electrode).

5. Settings on the power supply:
   - 30 Volt and 0.1 Amp for overnight runs at room temperature
   - 60 Volt and 0.22 Amp for 1 to 4 hours at room temperature
   - 90 Volt and 0.35 Amp for short runs with cooling at 4°C

We will use settings of 60 Volt and 0.22 Amp for 1.0 hour at room temperature.

6. After transfer is complete remove the PVDF from the cassette.
**NOTE:** The gel may also be stained with Coomassie blue, to check if all of the protein has been transferred.
Procedure: Staining of PVDF membrane with Coomassie Blue

1. Incubate the PVDF in 0.1% (w/v) Coomassie® brilliant blue R-250/40% methanol/10% acetic acid for 5 minutes.

2. Destain the PVDF membrane for 15 minutes in 40% methanol/10% acetic acid.

3. Rinse for no longer than 1 minute in 90% methanol/5% acetic acid.

4. Rinse in distilled water for at least 4 hours changing the water several times. Dry between Whatman No. 1 filter paper and store.

5. Bands of interest would be excised using a razor blade for amino acid analysis or protein/peptide sequencing. The excised bands may be stored at -20°C in a sealed microcentrifuge for later use.

Buffer formulations

Transfer Buffer: 25 mM Tris, 192 mM glycine, 20% v/v methanol, pH 8.3
Mix 3.03 g Tris, 14.4 g glycine and 200 mL of methanol. Add distilled water to 1 L. DO NOT adjust pH with acid or base. Use analytical quality methanol to avoid metal contamination from low quality methanol.

Equilibration Buffer: 25 mM Tris, 192 mM glycine, pH 8.3
Mix 3.03 g Tris and 14.4 g glycine. Add distilled water to 1 L.

References:


The Bio-Rad Protein Assay is a simple and accurate method for determining the concentration of solubilized protein. The assay is based on the method developed by M. Bradford in 1976. The procedure involves the addition of acidic dye to the protein solution followed by the measurement of the solution's absorbance at 595 nm on a spectrophotometer. A differential color change of the dye will occur in response to various concentrations of protein. The maximum absorbance for an acidic solution of Coomassie Brilliant Blue G-250 dye will shift from 465 nm to 595 nm when binding to a protein occurs. The dye will bind primarily to basic and aromatic amino acids, especially arginine. It was found in 1978 by Spector that the extinction coefficient of a dye-albumin complex solution will stay constant over a 10-fold protein concentration range. Thus, accurate quantitation of protein can be obtained by selecting an appropriate ratio of dye volume to sample concentration and applying Beer's Law.

\[ A = \varepsilon c l \]

\( A \) = absorbance  \( \varepsilon \) = molar absorption coefficient (molar absorptivity)  
\( c \) = concentration  \( l \) = pathlength

Interference may be caused by chemical-protein and/or chemical-dye interactions (see table listing reagents NOT directly affecting the development of the dye color). Basic buffer conditions and detergents will interfere with this assay. It is possible that some of the listed reagents will produce interference in combination with certain proteins (since not every protein-chemical reagent combination has been assayed).

**Procedure: Quantifying protein concentration in solution**

1. Five dilutions of the protein standard (BSA) will be used for this assay. A 2.0 µg/mL, 4.0 µg/mL, 6.0 µg/mL, 8.0 µg/mL and 10.0 µg/mL solution will be used. In any protein assay, the best protein to use as a standard is a purified preparation of the protein being assayed. When an absolute reference protein is not available, a relative standard should be used. A good relative standard will have similar properties to the protein being assayed and will have a color yield similar to that of the protein being assayed. If only relative protein values are desired, any purified protein can be used as a reference standard. Label 7 glass culture tubes with the known protein concentration (“2”, “4”, “6”, “8” and “10” µg/mL), “Unknown” and “Blank”

2. Pipet 1000 µl of each protein standard dilution (“2”, “4”, “6”, “8”, “10” µg/mL), the unknown protein solution (“Unknown”) and water (“Blank”) into the appropriate clean, dry glass culture tube.

3. Add 250 µL of dye reagent concentrate to each tube and vortex. The dye reagent contains dye, phosphoric acid and methanol.

4. Incubate at room temperature for 10 minutes.
5. Measure the absorbance of each solution at 595 nm.

Instructions for use of the spectrophotometer:

Simple Reads Function

a. Click on the Simple Reads icon on the desktop.
b. Select Set-up, change Read at Wavelength to 595, make sure that the Ave Time is set to 1.0000 and the Y-Mode is Abs. Click Ok.
c. Select Edit->Edit Report and enter your name below the instrument line.
d. Transfer your blank solution to a clean cuvette and place in the instrument. Click Zero, then Read.
e. Transfer the first solution from the glass culture tube into an empty cuvette and place in the instrument.
f. Click Read.
g. Repeat step e. and f. for each glass tube (standard 1-5 and the sample).
h. Print the results (File->Print).
i. Exit the Simple Reads program (File->Exit). Click Ok when asked to save the data.

6. Plot the protein concentration (x-axis) versus the absorbance (y-axis) for the five standard solutions. From the absorbance of the sample, the concentration can be estimated.

References:


Reagents compatible with the Bio-Rad Protein Assay when using the standard procedure
(concentrations of reagents for the Microassay Procedure are 1/40 of those listed)

<table>
<thead>
<tr>
<th>Reagent</th>
<th>Concentration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acetate</td>
<td>0.6 M</td>
</tr>
<tr>
<td>Acetone</td>
<td></td>
</tr>
<tr>
<td>Adenosine 1 mM</td>
<td></td>
</tr>
<tr>
<td>Amino Acids</td>
<td></td>
</tr>
<tr>
<td>Ammonium Sulfate 1.0 M</td>
<td></td>
</tr>
<tr>
<td>Ampholytes 0.5%</td>
<td></td>
</tr>
<tr>
<td>Acid pH</td>
<td></td>
</tr>
<tr>
<td>ATP 1 mM</td>
<td></td>
</tr>
<tr>
<td>Barbital</td>
<td></td>
</tr>
<tr>
<td>BES 2.5 M</td>
<td></td>
</tr>
<tr>
<td>Boric Acid</td>
<td></td>
</tr>
<tr>
<td>Cacodylate-Tris 0.1 M</td>
<td></td>
</tr>
<tr>
<td>CDTA 0.05 M</td>
<td></td>
</tr>
<tr>
<td>Citrate 0.05 M</td>
<td></td>
</tr>
<tr>
<td>Deoxylcholate 0.1%</td>
<td></td>
</tr>
<tr>
<td>Dithiothreitol 1 M</td>
<td></td>
</tr>
<tr>
<td>DNA 1 mg/mL</td>
<td></td>
</tr>
<tr>
<td>EDTA 0.1 M</td>
<td></td>
</tr>
<tr>
<td>EGTA 0.05 M</td>
<td></td>
</tr>
<tr>
<td>Ethanol</td>
<td></td>
</tr>
<tr>
<td>Eagle's MEM</td>
<td></td>
</tr>
<tr>
<td>Earle's salt solution</td>
<td></td>
</tr>
<tr>
<td>Formic acid 1.0 M</td>
<td></td>
</tr>
<tr>
<td>Fructose</td>
<td></td>
</tr>
<tr>
<td>Glucose</td>
<td></td>
</tr>
<tr>
<td>Glutathione</td>
<td></td>
</tr>
<tr>
<td>Glycerol 99%</td>
<td></td>
</tr>
<tr>
<td>Glycine 0.1 M</td>
<td></td>
</tr>
<tr>
<td>Guanidinede-HCl</td>
<td></td>
</tr>
<tr>
<td>Hank's salt solution</td>
<td></td>
</tr>
<tr>
<td>HEPES buffer 0.1 M</td>
<td></td>
</tr>
<tr>
<td>KCl 1.0 M</td>
<td></td>
</tr>
<tr>
<td>Malic acid 0.2 M</td>
<td></td>
</tr>
<tr>
<td>MgCl₂ 1.0 M</td>
<td></td>
</tr>
<tr>
<td>Mercaptoethanol 1.0 M</td>
<td></td>
</tr>
<tr>
<td>MES 0.7 M</td>
<td></td>
</tr>
<tr>
<td>Methanol</td>
<td></td>
</tr>
<tr>
<td>MOPS 0.2 M</td>
<td></td>
</tr>
<tr>
<td>NaCl 5 M</td>
<td></td>
</tr>
<tr>
<td>NAD 1 mM</td>
<td></td>
</tr>
<tr>
<td>NaSCN 3 M</td>
<td></td>
</tr>
<tr>
<td>Peptones</td>
<td></td>
</tr>
<tr>
<td>Phenol 5%</td>
<td></td>
</tr>
<tr>
<td>Phosphate 1.0 M</td>
<td></td>
</tr>
<tr>
<td>PIPES 0.5 M</td>
<td></td>
</tr>
<tr>
<td>Polyadenylic acid 1 mM</td>
<td></td>
</tr>
<tr>
<td>Polypeptides (MW &lt; 3000)</td>
<td></td>
</tr>
<tr>
<td>Pyrophosphate 0.2 M</td>
<td></td>
</tr>
<tr>
<td>rRNA 0.25 mg/mL</td>
<td></td>
</tr>
<tr>
<td>tRNA 0.4 mg/mL</td>
<td></td>
</tr>
<tr>
<td>total RNA 0.30 mg/mL</td>
<td></td>
</tr>
<tr>
<td>SDS 0.1%</td>
<td></td>
</tr>
<tr>
<td>Sodium phosphate</td>
<td></td>
</tr>
<tr>
<td>Streptomycin sulfate 20%</td>
<td></td>
</tr>
<tr>
<td>Triton-X-100 0.1%</td>
<td></td>
</tr>
<tr>
<td>Tricine</td>
<td></td>
</tr>
<tr>
<td>Tyrosine 1 mM</td>
<td></td>
</tr>
<tr>
<td>Thymidine 1 mM</td>
<td></td>
</tr>
<tr>
<td>Tris 2.0 M</td>
<td></td>
</tr>
<tr>
<td>Urea 6 M</td>
<td></td>
</tr>
<tr>
<td>Vitamins</td>
<td></td>
</tr>
</tbody>
</table>
Folin-Lowry Protein Assay

The Folin-Lowry protein assay is more accurate and has less protein-to-protein variability than Coomassie® dye based protein assays.

Procedure:

1. 0.4 ml of protein (10-100 µg protein)
2. Add 2.0 ml of reagent D
3. Let stand for 10 minutes
4. Add 0.2 ml freshly prepared Folin-Ciocalteu reagent (Fisher)
5. Let stand 30 minutes
6. Read absorbance at 750 nm

Solutions:

A. Na₂CO₃ (2% in 0.1 N NaOH)
   20.0 g Na₂CO₃
   4.0 g NaOH
   dissolve in 1 L distilled H₂O

B. CuSO₄·5H₂O (0.5% in 1% Na citrate)
   0.5 g CuSO₄·5H₂O
   1 g Na citrate
   dissolve in 100 ml of distilled H₂O

C. Folin-phenol reagent
   Folin Ciocalteu 2N dilute 1:1 with distilled H₂O

D. Mix
   1 ml solution B
   50 ml solution A

**Use BSA as standard

Reference:  JBC 193: 265-275 (1951)
Protein/Peptide Sequencing

The chemical procedure employed by automated protein/peptide sequencers is derived from the method originated by Pehr Edman in the 1950s for the sequential degradation of peptide chains. Phenylisothiocyante (PITC) reacts with the amino acid at the amino terminus under basic conditions (provided by N-methylpiperidine/methanol/water) to form a phenylthiocarbamyl derivative (PTC-protein). Trifluoroacetic acid (TFA) then cleaves off the first N-terminal amino acid as an anilinothiazolinone derivative (ATZ-amino acid) and leaves the new N-terminus for the next degradation cycle. The ATZ-amino acid is then removed by extraction with N-butyl chloride and converted to a phenylthiohydantoin derivative (PTH-amino acid) with 25% TFA/water (see Figure 1). Several by-products are also formed during the Edman degradation chemistry and are shown in Figure 2. The PTH-amino acid is then transferred to a reverse-phase C18 column for detection at 270 nm. This process is repeated sequentially to provide the N-terminal sequence of the protein/peptide. A standard mixture of 19 PTH-amino acids is also injected onto the column for separation (usually done as the first cycle of the sequencing run). This chromatogram provides standard retention times of the amino acids for comparison with each Edman degradation cycle chromatogram. The HPLC chromatograms are collected using a computer data analysis system. To determine the amino acid present at a particular residue number, the chromatogram from the residue of interest is compared with the chromatogram from the previous residue by overlaying one on top of the other. From this, the amino acid for this particular residue can be determined (see Figure 3).

Sample Preparation for Protein Sequencing

**Sample Amount**

10 pmols is preferred, although a lower amount is acceptable.

**Sample Form**

I. In 30-150 microliters of volatile solvents such as water, acetonitrile, propanol, acetic acid, or formic acid.
II. On a PVDF membrane. A sample should be as concentrated as possible on the PVDF membrane (e.g. 1 µg/lane). Several bands can be used. The bands should be stained with Coomassie Blue, Ponceau S, or Amido Black. After staining/destaining, a blotted membrane must be rinsed thoroughly with deionized water. The whole membrane may be submitted with the bands marked or the bands may be cut out and submitted.

**Purity**

For liquid samples, the solution should contain only one protein or peptide. Buffers, SDS, salts, amino acids, primary amines, and other contaminants must be removed from your sample. These contaminants may affect the Edman degradation reaction on the instrument, contaminate the instrument or affect PTH amino acid detection. Samples submitted on PVDF (blotted from SDS-PAGE gels) should have well separated bands to minimize contamination.
**Cysteine Modification**

Since unmodified Cys residue cannot be detected, Cys should be modified (according to Fulmer, C.S. (1984) *Anal. Biochem.* **142**: 336) before sample submission if you wish to identify Cys.

**N-terminal Blockage**

If the amino terminus is blocked, the protein or peptide cannot be sequenced using Edman degradation. We perform de-blocking procedures and will discuss options with you if blockage is suspected.

**Glycosylation and Other Modifications**

Glycosylated amino acids and phosphorylated amino acids may result in blank cycles, reduced peaks or altered retention times.
Edman Degradation on the 494 Procise N-terminal Sequence:

**R1** (5% PITC in N-heptane)  
R1 (N-methylpiperidine/water/McOH)  
Provides the basic environment that the PITC needs.

**S3** (n-butyl chloride)  
Removes unwanted materials.

**S2B** (ethyl acetate)  
Removes unwanted materials.

**R2** (TFA)  
Cleaves PITC coupled amino acid from the N-terminus of the protein.

**R3** (TFA)  
Cleaves PITC coupled amino acid from the N-terminus of the protein.

**R4** (25% TFA/H2O)  
Converts the ATZ-amino acid to the more stable PTH-amino acid.

**Evaporation of the R4**  
Leaving a dried residue of the PTH-amino acid.

**S4** (20% ACN/H2O)  
Brings the PTH-Amino Acid back into solution.

**Analysis on the 140C Amino Acid Analyzer**

**PITC** - Phenylisothiocyanate  
**PTC** - Phenylthiocarbamyl  
**TFA** - Trifluoroacetic acid  
**PTH** - Phenylthiethylesternine  
**ATZ** - Anilinothiazolinone
Figure 2 Edman Chemistry By-Products

1. Diphenylthiourea (DPTU)

\[
\begin{align*}
\text{PITC} + \text{H}_2\text{O} & \rightarrow \text{Aniline} + \text{PITC} \\
\text{PITC} & \rightarrow \text{DPTU}
\end{align*}
\]

2. N-Phenyl,O-Methyl-thiocarbonate (PMTC)

\[
\begin{align*}
\text{PITC} + \text{CH}_3\text{OH} & \rightarrow \text{PMTC}
\end{align*}
\]

3. Diphenylurea (DPU)

\[
\begin{align*}
\text{DPTU} & \rightarrow \text{DPU}
\end{align*}
\]
Column: C-18, 2.1 mm X 220 mm
Solvent: A: 3.5% Tetrahydrofuran/water
         Buffer Premix added
         .005% TFA
         B: Acetonitrile/2-Propanol, 8-90%
Flow: 325 uL/minute
Detection: 269 nm
Useful references for amino acid analysis and protein/peptide sequencing:


INSTRUCTIONS FOR USE OF A PIPETTOR

Prepared by the Office of Biotechnology, Iowa State University

The following description is of the Labnet pipettor provided by the Office of Biotechnology. The instrument is designed to accurately measure volumes of liquid from 2 to 20 µl. Before using a pipettor, please read these instructions. Use water to practice loading and transferring liquids.

PURPOSE OF A PIPETTOR

Biotechnologists use a pipettor to transfer precise amounts of liquid from one container to another. The volume of liquid transferred generally is extremely small and is measured in microliters (µl). There are 1,000 µl in 1 ml.

CARE OF THE PIPETTOR

A pipettor is an expensive and delicate instrument that must be used with care. Misuse of the instrument can cause it to measure the incorrect volume of liquid or, in extreme circumstances, fail to measure any volume. The two most important factors to consider are:

1. Do not drop the pipettor
2. For the pipettor furnished by the Office of Biotechnology, do not adjust the volume to less than 2 µl or greater than 20 µl and do not twist the yellow pushbutton.

PARTS OF THE PIPETTOR

The primary parts of the pipettor are a yellow pushbutton (1) that is used to measure the desired volume, a calibration knob (2) that is used to set the pipettor for the volume of liquid to be measured, a digital display (3) of the volume that the pipettor is set to measure, and the pipette cone (4) on which a disposable pipette tip (5) is placed to hold the liquid. Two additional parts of the pipettor that may be used are a pushbutton (6) and an ejector (7) to remove a used pipette tip (5) from the pipette cone (4).

ADJUSTMENT OF THE VOLUME

The digital display (3) in the handle of the pipettor consists of three vertical numbers. The upper two numbers indicate µl and the bottom number indicates 0.1 µl. The red line between the top two numbers and the bottom number represents the decimal point. A setting of 070 is 7.0 µl, a setting of 075 is 7.5 µl, and a setting of 170 is 17.0 µl. The pipettor provided by the Office of Biotechnology is designed to accurately measure volumes between 020 (2.0 µl) and 200 (20.0 µl).

To set the pipettor for the desired volume, turn the calibration knob so that the digits increase or decrease, as required. The pipettor will be damaged if the calibration knob is forced to turn at settings below 020 or above 200.
METHOD FOR TRANSFERRING LIQUID

1 - Adjust the pipettor to the desired volume.

2 - Hold the pipettor in the hand so that the digital display is facing the person using it and the thumb can easily depress the yellow pushbutton.

3 - Open the box containing the pipette tips. Place the pipette cone into the pipette tip and press down firmly until the tip remains on the cone. Use of excess pressure can damage the pipettor. Close the cover of the box after the tip has been removed to minimize contamination of the remaining tips in the box. After the pipette tip is attached, do no let the tip come in contact with any object because it will become contaminated.

NEVER USE THE PIPETTOR WITHOUT A TIP ATTACHED because the entire instrument will become contaminated. If it accidentally occurs, rinse the pipettor thoroughly by loading and unloading 20.0 µl volumes of distilled water.

4 - Before the pipette tip is placed in the liquid to be transferred, press the yellow pushbutton to the first stop that can be felt (A) (See figure below)

![Diagram of pipettor](image)

If the button is pushed as far down as it will go, the desired volume will not be measured. If the button is depressed while it is in the liquid to be transferred, bubbles will be produced, which can make it difficult to get liquid into the pipette tip.

With the button depressed to the first stop, place the pipette tip into the liquid to be transferred (B). Slowly release the button while keeping the tip in the liquid (C). After the button is fully released, remove the tip of the pipettor from the liquid. Do not wipe the tip or let it come in contact with any surface. Keep the pipettor vertical at all times.

5 - Place the tip of the pipettor into the container to which the liquid is being transferred (D). If the container already contains liquid, place the tip into the liquid. Slowly press the yellow pushbutton down as far as it will go to eject all the liquid from the tip (E). With the button fully depressed, remove the tip of the pipettor from the container.
When the liquid being transferred is being added to another liquid, it may be desirable to mix the two. Place the pipette tip containing the liquid being transferred into the second liquid. Slowly depress the button down as far as it will go (E). Without removing the tip, slowly release the button to draw liquid back into the tip (C). Slowly depress the button down as far as it will go (E). Repeat the process several times. The last time, depress the button as far as it will go (E) and remove the pipettor from the container.

6 - Remove the used pipette tip by pressing down on the ejector button (F) or pulling the tip off by hand. Dispose of the tip in an appropriate container.

Revised 6/94
Equipment List--Workshop 9B

A) SDS-PAGE

1) 30% Acrylamide/Bis
2) 1.5 M Tris pH 8.8
3) 10% SDS
4) TEMED
5) Fresh 30% Am2S2O7
6) 0.5 M Tris, pH 6.8
7) Tank Buffer (12g Tris, 57.6g Glycine, 4g SDS, add H2O to 4 liter)
8) Sample reducing buffer
9) Low molecular weight MW marker
10) Staining solution (40% MeOH, 10% HOAc, 0.1% Dye, 50% H2O)
11) Destaining solution (40% MeOH, 10% HOAc, 50% H2O)
12) Protein Solution

BSA(66.2K): 1 mg/ml, Lysozyme(14.4k)): 1 mg/ml, β-Lactoglobulin(18.1k): 1 mg/ml, 5% SDS
13) Sample
5 μL protein solution + 20 μL reducing buffer, load 10 μL
14) Power supply
Run conditions: constant voltage, 180 V (about 40 minutes)
15) Razor Blade
16) Wrap
17) Parafilm

B) Blotting, Protein assay, Gel measurement, Sequencing

1) Equilibration buffer
100 ml 10x blotting buffer + 900 ml H2O
2) Transfer buffer
100 ml 10x blotting buffer + 200 ml MeOH + 700 ml H2O
3) Staining solution
4) Destaining solution
5) Rinse solution
90 ml MeOH + 5 ml H2O + 5 ml Acetic acid
6) Methanol
7) Power Supply
Blotting condition: constant current: 0.2 A, (80-100 v, 1 hour)
8) Protein assay
BSA standard: 2, 4, 6, 8 μg/ml
protein assay solution

NOTE: The source given above is not the only source for these supplies.